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Formulas, Functions and Charts

8.1 INTRODUCTION

In this leson you can enter formula and functions and perform
mathematical calcualtions. You will also be able to create charts
and graphics using the data. You can specify methametical
relationship between the numbers using the formula. Formulas
are used for simple addition, subtraction, multiplication and
division as well as for complex calculations. Functions are built
in formulaes. The users have to provide cell references and
addresses only. These are called arguments of the function and
are given between the left and right parenthesis.

8.2 OBJECTIVES

After going through this lesson you would be able to:

° use formulaes to get the desired result
° insert and edit picture from a file

° use functions

° create varioius charts

° draw graphics using clip art.
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8.3 FORMULAS AND FUNCTIONS

To manipulate data and to extract useful information from Excel
worksheets, formulas and worksheet functions play very
important role. In Excel, formulas are used to calculate results
from the worksheet data. When there is some change in the data,
such formulas automatically calculate the updated results with
no extra efforts on the part of the user. There is a new feature
introduced by Excel 2007, which enables you to create formulas
which use columns names from a table, when you are working
with table. This feature helps the user to make formulas much
easier to read.

A formula can have any or all of the following elements

° Must begin with the 'equal to' = sign.

° Mathematical operators, such as + (for addition) and / (for
division) and logical operators such as <, >

° References of cell (including named ranges and cells)

° Text or Values

° Functions related to the worksheets, for example SUM or
AVERAGE

The current cell in which you have entered a formula will display
the result after the formula is completely entered. Also, when you
select or click on a cell which is having some formula, the formula
will appear in the formula bar.

In Excel 2007, the formulas are available in the Formulas Tab. If
you click on the Formulas tab, you can see the corresponding
ribbon display with available formulas, as shown below.

(1 d ¥ ArunBakshiChapterFormatting and formulas and fundion - Microsoft Excel —
" Home Insert Fage Layout Formulas Data Roeviews Wiew Developer W - 2 X
u X AutoSum T i Logical - - = 57 Define Mame ~ o .:l
i il d L
[ Recently Used = [A Test - m-
Insert . i . Name Farmula | Caloulation
Function [[E? Financial - j_'l Date &Time = [If]™  mManager ES Create from Selection Auditing ~
Function Library Defined Mameés
| F3 1r %|
A B z £ G H S|
Lsl
Formula | —T = PP PR PSR P TIrI E— r
Bar M 4 ¢ M| Sheetl - Sheet? - Sheetd . ¥J 0 ! Iil ] 0
Ready | B3 EEE [0 ELT] s = il (Fip




Formulas, Functions and Charts ::

169

Following are a few examples of formulas:

Iz"":?;: Lu WY - =
= = Hame Insert Page Layout Farmulas Crata Revieww Wisw
Ty ] ‘f‘; Cut 11 jas aml| [ = = E||a-"\,',~'~*--_l i
= Copy 3 i 3
Pajte ,_-'" Format Painter | B =3 o |[_H | R = I |E = EEI' i= EE| |
| Clipboard la Font Aligrnm
L suM v (> ¥ w f=| =B3+c3+D3+E3
A Bt C D ' E | E G
1
2 MName F‘hvsics]l‘.:hernistr Maths English |Tuta|
_ 3 |Ashok Sharma 59 39 100 100] =E3+C3+03+E3
4 |Rajesh B8 i Ba 88
5 |Ratul rrd 99 G5 99
& |Anurag 88 28 78 rri
7 | Garurav rri FT S8 55
8 Prashant 66 e 28 rr
9 |Taslim rrd GG =k 28
10 |Ranjeata 55 Erd 72 rr
11 | Priyvanka rrid S5 EL =
12 Monika B3 35 = o8
Fig. 8.2

In the above example, in the cell F3, just type = B3+C3+D3+E3.
It will return sum of the marks in physics, chemistry, maths and

English.
MName Physics|ChemistryMaths |English ||Total
Ashok Sharma 99 99 100 109 398!
Rajesh 88 76 88 24
Ratul 77 29 66 BT
|Anurag 88 58 78 7
|Garurav 77 77 o8 5
Prashant =1+ 44 83 7T '
Taslim 77 66 33 Y :
|Ranjeeta S5 77 78 7L
|erivanka 77 55 84 7
Monika 88 28 76 o
Neelam 88 77 67 &
|Deepak 77 99 87 s3
|Elakshi 99 88 87 i
Sonakshi 66 77 56 71
Gunjan 77 66 83 64
|Mohit 88 77 77 71
|Chhavi 99 88 66 =4
Kaku 77 99 88 e

Fig. 8.3
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Copying a formula

In above exaple just drag the handle and bring down to cover the
remaining cells in the column total. This will automatically copy
the formula and calculate the corresponding sum of the
respective rows of the other students.

MNMarme Physicslchnmistry NMaths Englizh Total
Asholk Sharma a9 ag 100 200§ =zgas
Rajesh a8 TE a8 554 sS40
Eatul 77 ag 55 B | =A71
Anuras 85 S5 TE e G511
Garuraw 77 77 as = =07
Prashant 1= _ 35 s || 27D
Taslim 77 = as == =29
Ranjesia =25 i TS i 237
Priyvanka 77 S5 =4 7 291
ronika S8 28 Fi = o5 50
MNeelam == 77 &7 = z9s
Decepak 77 EE, s7 S5 =18
Elakshi EE == =7 S= =a0
Sorakshi &5 77 56 7 A 276
|Gunjan F7 55 =8 E= 297
[rachit == 77 77 77 =1g
| ChRhawvi ag =8 = == =41
= 77 EE == EE 63
Fig. 8.4

Some other examples of formulaes:
IfA1=2,B1=3,Cl=4,D1 =5 then
(i) =B1*C1 will give resultas 3 * 4 = 12
(i) =A1*B1-Cl+Dlwillgiveresultas2*3-4+5=7
(iii)) = ((A1 * B1) + C1)/D1 will give result as ((2 * 3) + 4)/5
=(6+4)/5=10/5=2
Auto sum feature

The sum of cell values can also be done with the help of AutoSum
feature also.

Following steps explains how to do that.

° Click on the cell F3.
) Select the Formulas tab

° Click AutoSum from the function library group.
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) Select Sum

° Press Enter

Alternatively, you can write = SUM(B3:E3) in the Cell F3 to get
the sum of the Physics, Chemistry, Maths and English marks.

Pictorial illustration is shown below:

G 9
o e

Home Insert Page Layout | Formulas Data Review

T2 8B @00 @ @

Function

Insert Butosum|Recently Financial Logical Tex't' Date & Lookup & Math

x > Time = Reference - & Trig =

Function Librarny

Average

Count Murbers

£ |

5.1.. o
2 MName RAin stryMaths English |[Total
E @ kore Funcdions... o3 100 100
4 |Rajest s 76 88 88
5 |Ratul 77 EE) 66 39

A B C D . B G H
Name ___|PhysicsChemistryMaths |English _|Tota
\Ashok Sharmap 99 99 100 100} =SUM | SRS
Rajesh 83 76 88 88| | SUMinumberl, [number2], .| |
Ratul 77 99 fif 99

B C D E F
1
2 Name Fh\,r:i:r.IChemi:tr',lMa'th: English |Total
3 |Ashok Sharma 99 99 100 100)f 398
4 |Rajesh 88 76 88 88
Fig. 8.5

Apart from sum there are other functions also, like average, Count
Numbers, Max, Min and many other Functions.
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- | &= AutoSum "I ﬁ;l Lo
- "
= Sum
Insert
Function Sverage
Cournt Numbers
EAax
P1im

3 |lAsho rMore FPunctions...

m | e = __ _w T P
o - - - —— . — E—- - [ 5 ——

Fig. 8.6

Sum ( ) : Adds all the numbers in a range of cells.
Syntax SUM(numberl,number2, ...)

Maximum number of arguments can be 255 i.e. numberl,
number?2 ... number255.

Sum function is having different forms. You can choose as per

your need.
SLIM 2 %~ S| =sum
A B C D E F G H | J K

1

2 Mame Fhv:lcslthnrnl:try Maths |English |To1::| |

3 |Ashok Sharma EE] 39 100 100] =51
4 |Rajesh 8B 76 23 BE| | | Adds all the numbers in a range of cells J
5 |Ratul 77 39 66 95| | 4 sumF

6 |Anurag 88 88 78 77 I'{li SUMIFS

7 |Garurav 77 77 98 55| | £ SUHPRODULCT

el SUMS

8 Prashant GG 44 23 () LM M

9 |Taslim 77 66 93 &8 _F. SUMEZRYE
10 Ranjesta 55 77 78 77| | & sumEmz

1 L T PR TN PR TT == oA . | |

A B C D E F G

1

2 Name Physics|ChemistryiMaths |English |Tnta||

32 |Ashok Sharma 99 99 100 1DDJ =sum(B3:E3)

4 |Rajesh 88 76 38 gs| [

=) . . — .- _ - __1 |

Fig. 8.7

SUMIF(range, criteria, sum_range) : This form of sum functions
is used to add the cells with respective to a given criteria.

Range : A group of adjacent cells
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Cells within a range must be numbers or names, arrays, or
references which are having numbers. In sumif function the
blank and text values are ignored.

Criteria: It can be a number, expression, or text to define which
cells will be considered for the addition e.g. criteria can be fixed
as 12, “12”, “>12”, or “mangoes”.

Sum_range: These are the actual cells to be added if their
corresponding cells in range match criteria. In case the
sum_range is avoided, then the cells in range are both evaluated
by criteria and added if they match criteria.

Example
Ei:"u Wil - ArunBakshiChapterFormatting and formu
. Hume [r:sert Pagel.a;ﬂut Farmulas a Ra'new '."I-E'." D-:-I'EI':IPEr
3 3 Define Hame t.
i Eﬁj@ﬁmﬁﬁﬂﬁﬁ'ﬂ 2 i
—  fi- Usein Formulz I
Imsert | AutoSum Recently Financial Logical Texst Date & Lookup & Math More Hame = g ;
Fundtion = Iop = = = Time~ Reference= & Trig~ Functions~ | Manager 2= Create from Selection |
Fumction Library Defined Names
I m n cal
| ELIM X o Jie | =SUMIF(B3:E3,">99" B3:F3)
A B L U E F s H I J L
1 \
2 MName thsics!themlstryl‘ﬂaths English Tatal|5um|f | \
3 |Ashok Sharma 93 98 100 100 398]=’5UMIF|:33:E3,"}95‘",53:E3'-
4 Rajesh 84 76 a0 § SUMIF{range, criteria, [sum_range] |

AN

Formmila Bar

In above examples, the function SUMIF adds only those values
in the cells (B3, E3) which are greater than 99. i.e., it will add the
values from cells D3 and E3 only and hence the result is 100 +
100 = 2000

| £a - | fx | =sumM{B4:E4)

A B C D E F G H
1
2 MName P'I'l'l,.nrsic:.ll::h«:rr'li:'l:r'g.nI Maths |(English |Total BSumif
3 |Ashok Sharma 99 98 100 100 398 EUE
4 |Rajesh 88 Fi= 88 88 340
T p— — p— - Y

Fig. 8.8
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Average function () : It helps you to get the average of the
numbers. It returns the average (arithmetic mean) of the
arguments.

Syntax : AVERAGE(number, number2,...)

Maximum number of arguments can be 255 i.e. numberl,
number?2 ... number255.

Function Library Defir
| SLM - E o fr! =Average(B3:E3)

A B C (] E F G H I
2 Name Physics ChemistryyMaths  [English [Total
3 Ashok Sharma 23 99 100 100] 398
4 Rajesh 28 76 38 58 340

H3 - f | =AVERAGE(B3:E3)

A B C D E F G H I
1
2 MName thsicslchemistrvhﬂaths English |Total |Sumif Min
3 |Ashok Sharma 99 39 100 100 398 20 99.5
4 |Rajesh 28 76 25 gz 340 | |

Fig. 8.9

Min function ( ) : It helps you to get the minimum of the
numbers.Returns the smallest number in a set of values. Syntax
MIN(numberl,number?2,...)

Maximum number of arguments can be 255 i.e. numberl,
number?2 ... number255

UM » (2 X o f| =min(B3,F3)

A B C D E F G H |
1
2 Name Physics ChamistryMaths  [English |Total [Sumif  |Average [Min [
3 Achok Sharma a3 99 100 100 398 200 93.5 “.‘nn{EIE,'—Si
4 Ralesh LE Th AR gal  34n I

H12 - (2% o L

A B = o E F a_. e I
1
2 Name Physies ChemistryMaths  [English  |Total |Sumif |Average n
3 Ashok Sharma 595 39 100 100 393 200 99.5 99 i
4 |Rajesh g8 TG 55 &a 340

Fig. 8.10
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Max function ( ) : It helps you to get the maximum of the
numbers. Returns the largest number in a set of values. Syntax
MAX(numberl,number2,...)

Maximum number of arguments can be 255 i.e. numberl,
number?2 ... number255.

| SUM - (3 % o fu| =max(83,e3)
A B C D E F G H | il
1
2 MName Physics ChemistryMaths [English |Total [Sumif |Average |Min P |
3 |Ashok Sharma 95 99 100 1o0f 398 200 99.5 Elfll max{EE,Eﬂ
4 |Rajesh 32 76 83 ] D) [ [

A B C o E F G H | J
1
2 MName Physicgd ChemistryMaths  [English [Total [Sumif  |Average |Min Max
3 Ashok Sharma 99 99 100 100 395 200 99.5 99 100 ;
S - = A A B { m—
Fig. 8.11

Now drag the handle of cells G3,H3,13,J3 to cover each row of the
respective column. You can see the corresponding functions are
automatically copied in the respective columns and automatically
values are calculated. See the figure below.

IE?;;) — - ArunBakshiChaptaFomsttin
:. Hema Inzert Paga Layouwt Farmulss Diata Reviews Wi Devalaper
=y P o 53 A0 Deefine Mame =
K Z BB ERE e s oo
Insert AutoSum Recently Financial Logical Test Date & Lookup & Math Plare Mame
Function - Wsed - = - - Time~ Reference = & Trig= Funciions = || Manages & Create from Sel
Function Library Defined Mames
I N1S - A |
| s B C o E F G H 1 1
1
2 Mamae Physies Chamistry Maths  |English  |Tatal [Sumif Avarags |Min Max 1
2  Ashok Sharma 33 EE] 100 100|  3mE 200 99.5 EE] 100
4  Rajesh EE 76 EE] ] T o 25 a3 [ |
5 Ratul 77 EE] (13 a9 31 o 85.25 7 99
6 Anurag 83 BE Fi:] 77 331 0 82.75 77 88
7 Garurav 77| 77 L 55 307 o T6.75 7 77
& Prashami 66 43 G 7| 2R o G8.75 G5 77
8 Taslim 77 G oz 28| 325 o 82.2% 77 EE |
10 Ranjeeta 55 77 78 b o 71.75 A5 77
11 Priyanka 77 55 B4 75 291 o T2.95 7 77
12 Monika 88 BE i a5 350 o 575 & a5
13 Meelam B8 77 a7 35 298 o Fil.5 55 2 |
14 Despak 77 EE] a7 - 318 o 3.5 77 EE
15 | Elakshi 33 EE g7 GG 240 o 25 EE] EE)
16 Sanakshi [ 77 =1 T 276 o 69 =13 EE
17 Gunjan 77 66 & G5 297 o Ta.25 77 7
1E Mohit 83 77 77 7 319 o Ta.75 G5 85
17 Chhavi 33 G a6 G5 il o 83.25 23 33
20 Kaku 77 EE] 5] EEIIETE o 90,75 77 93

Fig. 8.12
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To use more functions

° Select Formula Tab
° Choose AutoSum from function library group, from formula
ribbon
° Click on More Functions... as shown below.
E“‘.l = - i ArunBakshiChapterF
- Hame Insert Page Layout Formulas Data Review Vigw Developer
= e - = e e=H 53 Define
fe BEeedeném@ s
Insert AutasumiRecently Finandial Logical Text Date & Lookup &  Math Mare Hame
Function - Used - - - Time = Referance = & Trig = Fundtions = || Manager BE Create
T Sum VFunction Library Defined M
C Average | s
Count Numbers - . D . E F G H |
1 A
2 Mame Ay stryMaths  [English |Total |Sumif  |Average |Min Max
3 Ashok —p— I 99 100 100| 398 200 95.5 99
4 Rajesh T i 76 Ba BB 340 i} 85 88
Fig. 8.13

When you click on more functions, a dialog box will appear as
shown below. You can choose a function as per your need by the
help of following dialog box.

Insert Function fhcd .4

Search For a Function:

Or selact a category: IMnsl: Recenkthy Usad '-'I

Select a Function:

SUM{numberl,numberZ,...}
Add=s all the numbers in a rangs of cells.

Help on bhis Funcion (] 4 Cance| I

Fig. 8.14
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8.4 CHARTS

Charts allow you to present data entered into the worksheet in a
visual format using a variety of graph types. Before you can make
a chart, you must first enter data into a worksheet. This section
explains how you can create simple charts from the data.
Formatted charts come in various types for diverse goals, ranging
from columns to pies, from lines to surfaces, etc.

8.4.1 Types of Chart

Microsoft Office Excel 2007 provides various types of charts to
help you to display data in different ways as per the need of the
viewers. You can create a new chart or can change the existing
chart, from the wide range of chart subtypes available for each
type of available chart types as given below

Column Charts

This type of chart is used to compare values across categories.
They give very effective results to analyze the data of the same
category on a defined scale.

Line Charts

Data represented in columns or rows in a worksheet can be
plotted with the help of line chart. Line charts can be used to
display continuous data over time with respect to a common
scale. Thus Line Charts are best suitable for viewing data trends
at equal intervals of time. The horizontal axis is used to represent
the category data and all the value data is distributed uniformly
along the vertical axis.

Pie charts

In a situation where one has to show the relative proportions or
contributions to a whole, a pie chart is very useful. In case of pie
chart only one data series is used. Small number of data points
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adds more to the effectiveness of pie charts. Generally there
should be maximum five or six data points or slices in a pie chart.
If the points are more in number then it becomes very difficult
to interpret the chart.

Also, it is very important to note that the values of to be used in
the pie chart must be all positive. If there are some negative
values, in that case the negative values will be automatically
converted in to positive values, this will be desired.

Bar Charts

Bar charts are used to show comparisons between individual
items. To make a bar chart the data should be arranged in the
form of rows and columns on a worksheet.

Area Charts

The data which is arranged in the form of rows or columns on a
worksheet can be plotted in an area chart. Area charts are used
to highlight the degree of a change over time. Area charts are also
used to draw attention to the total value across a trend.

XY (Scatter) charts

XY charts are also known by other names like scatter grams or
scatter plots. The point of difference between XY charts and other
types of charts is that in XY charts both axes display values i.e.
they have no category axis. Such type of charts is generally used
to show the relationship among two variables.

Stock charts

Stock chart can be used to plot data arranged in columns or rows
in a particular order on a worksheet. As the name is self
explanatory, this chart is used to demonstrate the fluctuations
with respect to stock market prices. Even scientific data can be
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plotted by stock chart, e.g., the fluctuation of daily or periodic
temperature. The data must be arranged in a correct order to
generate stock charts. Say, for example to make a simple high-
low-close stock chart one should organize his/her data with High,
Low and Closed entered as the headings of the columns in the
respective order.

Surface charts

Such type of chart is used in situations where both categories and
data series are numeric values. This type of chart is useful in
situations where the optimum combinations are found among the
two sets of data. Data should be arranged in columns or rows in
a worksheet can be plotted in s surface chart. The colors and
patterns indicate the areas which are in the same range of set of
values, as it happens in case of a topographic map.

Doughnut charts

The conditions to draw doughnut charts is that the data has to
be in the form of rows or columns. As in the case of a pie chart,
the doughnut chart illustrate the relationship of parts to a whole,
but it is able to get more than one data series.

Bubble charts

A bubble chart can be used to plot the data values which are
arranged in the columns of a worksheet so that x values are listed
in the first column and matching y values and bubble size values
are listed in adjacent columns.

Radar charts

The radar charts compare the aggregate values of a number of
data series. Radar chart can be plotted with the data which is
arranged in columns or rows on a worksheet.
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8.4.2 Components of a Chart

Y Axis Vertical Major Grid
Y AT vajue X Axis Chart Title Horizontal Major Grid
Categor / Da)ta
y
v
Result of Students

v Havi SrAnEr Wiohen li reesh hiweta kFernil I3
M L2
A
r 100
k
5 Al
5

b
c
il

a0
T
e
d 20

0
Mame of stuclents < X Axis
W Physics WChemstry B athe WBiglesy W EInglizh
Tick / Legend

Fig. 8.15
Chart Title - A title given to the whole chart.
X-Axis Title - A title given to the X-axis data range.
Y-Axis Title - A title given to the Y-axis data range.

X-Axis Category - These are the categories of the data which have
been plotted. These are taken from the first column or first row
of your data range.

Y-Axis Value - This is the data range marked to plot the data
series.
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Data Labels - The values of the data series plotted.

Legends - Specifies the colour, symbol or pattern used to mark
data series.

Tick Mark - These marks are used to show the scaling of X-axis
and Y-axis.

Grid Lines - Displays lines at the major intervals on the category
(x) axis and/or Y-axis

How to Draw a Chart in Excel 2007

In Microsoft Excel 2007 chart wizard is removed and also not
brought back in Excel 2010 also. Instead the ribbon is provided
as a new place to get your chart related needs full filled. The
buttons on the Insert tab of the ribbon are just the starting point
to make a chart. After we get the ribbon it becomes very simple
to start making a chart. Whenever we click on some component
of chart, we observe that the Chart Tools are displayed to the
ribbon. Three additional tabs which provide a variety of chart
design, layout and formatting options, will also be added.

First, the Layout tab, is used to add all sorts of elements related
to chart or change the way they are shown in the chart. Second,
the format tab is used to apply special effects which were not
available in the earlier versions of the Excel, such as the bevel
effect etc. It may be little difficult to be acquainted with this new
type of chart interface, but once you start working, you’ll be proud
to show off your professional looking results.

It is worth mentioning that you can right click on an element of
the chart for quick access to specific features with respect to that
particular element e.g. if you right click on any chart axis, you will
get Format Axis dialog box.

Following steps are given to draw a Chart

1. Enter data in the work sheet: Suppose you entered data as
given in Fig. 8.16.
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(Da) W - - ) 7 ArunBakshiExcelDemoSheet N = = X
- Humeilnsert | Page l| Furml.| Data | RHI'iHIViEW | Devehi'@ - 8 X
Al - 'i‘ .fr‘ Name
A B C D E F E
1 |[Name Physics  [ChemistnyMaths  |Biology |English
2 |Ravi 80 88 79 7 88 =
3 Shankar 70 Il 98 66 7
4 Mohan 90 67 6 78 63
5 Rajneesh 98 87 36 98 78
6 |Shweta 99 36 66 7 93
7 |Komal 98 78 77 68 76
& |Amit 87 76 29 89 67
3 I
4 4 » M| Sheetl i m .
Ready ] z=2Tm 1) - ] +
Fig. 8.16

2. Now select data range: By using the mouse high light the
range of data you want to take (see Fig. 8.17).

F .1

(D) bd ¥ - & - ) | 5 ArunBakshiExcelDemoSheet A - = x
Home IInsert | Pagtl| Forml.| Data | Rwiﬂi‘ufitw | Ii}e'l.relnilﬁ:I - 2 X
Al - 'i‘ .fr] MName ¥
A B C D E F E
1 |Name Physics Chemistry Maths Biology |English
2 |Ravi 80 a8 79 T7 88| |=
3 |Shankar 70 77 98 66 7
4 |Mohan 90 67 56 78 68
5 |Rajneesh 98 87 56 93 78
B |Shweta 99 o6 66 [ 98
7 |Komal 938 78 77 638 76
8 [Amit ar 76 99 a9 E-?n
T{S_("i ..... S HEEH"TTI. - : |
Average: 79.62857143 Count: 48  Sum: 2787 &5/ 1]

Fig. 8.17

3. Click Insert Tab and select a chart type from the chart
group
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ERelE

FivotTable Table

)

Tables

) -- ] |7 ArunBakshiExcelDemoshest - Microsoft Excel e [ By
el ....'.’?E'?..'t?!’?'f!t.. _ Fomulss  Data  Redew  View  Dewioper @ - & X
[G] Clip At fle Line - gl Area ~ (=] Test B Lﬁ =
E}Shap:s =l &R Fie - |:-: Scatter - == Header & Footer b
Ficture ( ] Hyperlink
T Smartart ([ SaBar - 1) Other Charts ~ Al wardart - [y
Hlustrations Charts fu Linls Text

4.

Fig. 8.18

Select the sub type of chart

.

LIrI-E =

—_—

[ =2"_"4 o

i

== e s e

mf——=--ml_

A

=
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Fig. 8.19
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2 |Faw 0 55 73] 0 3| | 120
3 [sharicar £ 77 ag| [T 7
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5 [Rajneesh S 57 | 3] 72
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5. Select the Title of the chart

a. To give a title to a chart, click on the chart. Now you
can see layout tab available. Click on Layout tab.

b. Choose(click) on chart title option available in the
Label group

“ Ho-p-0 5 ArunEakshiExcelDemoshest - Micrasoft Bxcel Chart Toals = o
Home  Insert Page Leyout Formules Diete Review  Wiew Developer Diesig armat -0 x
Charl Area 8 Ficlure E‘ I =] Legana = E @ ﬂlj [38] Chart W J [E] Linas - =
51. Format Selection TShaprs v |38 Data Labels - i] Chart Fioor - | Up/Down Baars ~
faps Gridines | Piol Trendlme Fropaties
&9 meset 1o Maben Thyle Ed Test Bon ,uﬂ [rata Table = * . Arese () 3D Retation [ Eror Ears - .
Cument Selection Inzerk Labels Axes Background Analysis
| Chart 2 - 5
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C. Click on the chart title and write a title.
Result of Students
120
100

80

80

40

20

Fig. 8.23

Give a name to X-Axis

M Physics

B Chemistry
= Maths

W Biology

W English

e

Click on Layout tab. Then select Axis Titles from Labels

Group. Select Primary Horizontal Axis Title, as

below.

shown

Trendline

Ld

elDemoSheet - Microsoft Excel Chanuls

Data Review Developer Design Layout Format

ol h_IJ ™ 8 Chart wall -

J Chart Floor =
Axis |Legend Data Data Aues Grldlln:s Flot N )

Titles=| ~  Labels ~ Table ~ - Area ~ [J) 3-D Rotation
_:@ Primary Horizontal Axis Title » : MNone
| @ Primary Vertical Axis Title y I _:I: ] Do not display an Axis Title

YITPTYTIRPEYY WPPTRT VIR PR T —  Title Below Axis
* |En E"Sh I =) l Drs.plnu}' Title below Horizontal Axis and [
— resize chart
77 28

More Primary Horizontal Axis Title Options...

66 77 : - -

Fig. 8.24
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Result of Students

120
100
BO
50 B Physics
40 B Chemistry
20 o Maths
0 W Biology
jS'\ d:\"'_ﬁ“ "!}\F ‘éf‘ _.f:} 0((&‘ 15'55' B English
o @@ o +

>

e - o
Fig. 8.25
Now, click on the Axis Title and write an X-axis title.
Result of Students
120
100
BO
&0 W Physics
40 W Che mistry
20 = Maths
0 | Biology
W English

Fig. 8.26

Follow the same steps to give a title to Y-axis.
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Editing of a Chart
1. How to change the legend position

Click on Layout tab. Then click on Legend option available
in Labels Group.

Now choose a position to show legend.

1Sheet - pdicrosaft Excel Chart Tools
P awnr Wy Deayvalopar Dra=igry Layout | Format
. = T T | | TR 7 ][] Chart wiall =
(ol [clios] [(] || (ot | [[ESE b
- L] Chart Fioor -
Legeand| ata Crata SAmes Gridines Flot ) | T
- - Labels = Table — - - Arems — J 3-Or Rotation
I i Mone E Background
1 ||I|Ih Turn off Legend
Al Show Legend at Right i I | W L
I -I_l_l-_E:JI Show Legernd and align
LN rigt I
A = Show Legend at Top
|riline Show Lagend and top
— aligmn — LT L ————— ————— =
b = Show Legend at Lerle
| [EHlam]  Sheww Leaena snd sign Result of Students
left
=N il Showw Legend at Bottom
—] _'_“-_,-\_-__-,i Showw Legernd armd aligm
Battom
i . DOverlay Legend at Right
[riFEEl Show Legend at right of
the chart withouwt resizirng
 re Overlay Legend at Left
|5l Shows Legend at laft of
the chart vwithowt resizimg
kore Legend Options...

Fig. 8.29

Result of Students

Rawi Shankar Maohan  Rajneezsh sShweta Kamal Armit
.::-_thsir_'s W Chemistry B Mathz BHBiclogy ®H Engligm
I e — aca e e ._k_
Fig. 8.30

2. How to change the position of the Data Labels

Click on Layout tab. Then click on Data Label option
available in Labels Group.

Now choose a format to display data labels
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rAicrosoft Excel Chart Taals
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Fig. 8.31

Ravi Shankar Mohan  Rajneesh  Shweta Komal Amit

0

B FPhysics B Cheristry B Maths B Biclogy M English

Fig. 8.32

How to show Data Tables Along with Chart, with or
without Legend Keys

Click on Layout tab. Then click on Data Table option
available in Labels Group.

Now choose a style to display data table
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>soft Excel | CThart Tools
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Fig. 8.33

N Result of Students

Ravi shanker Mahan Rejrzesh Shueta Hamal Ak

g0 il 20 28 a5 =] a7
g8 7T 67 &7 56 78 76
= Msthe 79 BE 6 - 56 77 a9
W Biglagy - 77 =1 7B a8 e ] 8%

B English 88 T B8 78 SE 76 &7

B Physics B Chemistry B aths B Bislogy MEnglish

Fig. 8.34

Above diagram show the data table with legend option.
4. How to Hide/Unhide Grid Lines (Horizontal and Vertical)

Click on Layout tab. In the Axis Group, click on Gridlines
option then choose Primary Horizontal Grid Lines. Now
select appropriate style from the available options (None,
Major Gridlines, Minor Gridline, Major and Minor Gridlines)
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Follow the same steps for Vertical Grid Lines also, as shown
below.

a) Click on Layout tab. In the Axis Group, click on Gridlines
option then choose Primary Vertical Grid Lines.
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b) Now select appropriate style from the available options
(None, Major Gridlines, Minor Gridline, Major and Minor

Gridlines)
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8.4.3 Resizing the Chart

To resize the chart, click on its border and drag any of the eight
black handles to change the size. Handles on the corners will
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resize the chart proportionally while handles along the lines will
stretch the chart.

8.4.4 Moving the Chart

Select the border of the chart, hold down the left mouse button,
and drag the chart to a new location. Elements within the chart
such as the title and labels may also be moved within the chart.
Click on the element to activate it, and use the mouse to drag
the element to move it. Microsoft Excel automatically sizes titles
with respect to the size of the text. One can move titles with the
mouse but, cannot resize them.

8.4.5 Copying the Chart to Microsoft Word

A finished chart can be copied into a Microsoft Word document
or power point slide. Select the chart and click Copy. Open the
destination document in Word or a slide in power point and click
Paste.

8.5 GRAPHICS - AUTOSHAPES AND SMART ART

The AutoShapes feature of Excel 2007 allows you to draw a
number of geometrical shapes, arrows, flow chart elements, stars,
and more on the worksheet.

The steps to activate and use AutoShapes are
1. Click on Insert Tab.

2. From Illustrations Group, Click on Shapes

Dy

1 Mame  |Physics|Chemisin
2 R B B calouks

SRl e 1

.;i :I'H!HHP"I:I!E.'IH;-.
| Mehan LK v ey wor —r

Fig. 8.39
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Now Select the which you want to insert.
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Different categories of AutoShapes available in Excel 2007. We
will briefly discuss some of the here.

1. Lines - After clicking the Lines button on the AutoShapes
toolbar, draw a straight line, arrow, or double-ended
arrow from the first row of options by clicking the respective
button. Click in the worksheet where you would like the line
to begin and click again where it should end. To draw a
curved line or freeform shape, select curved lines from
the menu, click in the worksheet where the line should
appear, and click the mouse every time a curve should
begin. End creating the graphic by clicking on the starting
end or pressing the ESC key. To scribble, click the last
button in the second row, click the mouse in the worksheet
and hold down the left button while you draw the design.
Let go of the mouse button to stop drawing.

2. Connectors - These lines can be used to connect flow chart
elements.

3. Basic Shapes - Click the Basic Shapes button on the
AutoShapes toolbar to select from many two- and three-
dimensional shapes, icons, braces, and brackets. Use
the drag-and-drop method to draw the shape in the
worksheet. When the shape has been made, it can be
resized using the open box handles and other adjustments
specific to each shape can be modified using the yellow
diamond handles.

4. Block Arrows - Select Block Arrows to choose from many
types of two- and three-dimensional arrows. Drag-and-
drop the arrow in the worksheet and use the open box and
yellow diamond handles to adjust the arrowheads.

5. Flow Chart - Choose from the flow chart menu to add flow
chart elements to the worksheet and use the lines menu
to draw connections between the elements. We have drawn
a flowchart using lines, flow chart elements and connectors.

6. Stars and Banners - Click the button to select stars,
bursts, banners, and scrolls.
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7. Call Outs - Select from the speech and thought bubbles,
and line call outs. Enter the call out text in the text box
that is made.

Smart Art Graphics

Visual representation of information and ideas is called SmartArt
Graphics. They can be used to quickly, easily and effectively
communicate a message. The facility to create a SmartArt Graphic
is available in MS Excel 2007. You can copy and paste SmartArt
graphics as images into other programs such as Word and
Powerpoint.

To create a SmartArt graphic, one has to choose a type for
example, Process, Cycle, Hierarchy or Relationship. A type
represents a category of SmartArt graphic. Each type is having
several different types of layouts.

Steps to Create a SmartArt

1. Click on Insert Tab.

2. From Illustrations Group, Click on SmartArt
O = ArunBakshiExcelDemosSheet - v
Insert Page Layout Formulas Data Review View Developel
Ellal Loy | - L A = o=
Ll B8 (P 2 all X e sl
Picture Clip Shapes sSmartArt Calumn Line Pie Bar Area  Scatter
Art - - - - - = e
| Hiustrations Charts
- J | insert SmartArt Graphic |
B C Insert a Smartirt graphic to visually
@ communicate information.
] “

-\_.) ) SmartArt graphics range from
ol graphical lists and process
= _ - diagrams to mare complex
a )ga graphics, such as VWenn diagrams
and organization charts.

i Press F1 for more help.

Fig. 8.42
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Choose a SmartArt Graphic
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Fig. 8.43

3. Now choose a category (Say Hierarchy) and click OK.

Choose a SmartArt Graphic

oA
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A
>
'
]

e Process

[
T cpee a®a -
G =8 ®a2

sl
] Reletiorship U ]|

L

B Matrix
Hierarchy

& Pyramid . ) )
2 Pyram Uss to sheew hizrarchicel relationships
pregressing fram top to battam.

| o= J[ cocs |

Fig. 8.44

4. Now you can enter the values as shown below. To enter
values just click on the component where you want to enter
text and write the text.
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:Trpz your text here
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You can apply different effects on the SmartArt, by the help of
Design tab. Click on SmartArt. The Design tab will be visible with
its ribbon. Select appropriate group from the ribbon and apply
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Fig. 8.45
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8.5.1 Adding Clip Art

Clip is a single media file, including sound, animation,

movie.
Steps to insert a Clip Art

Click on Insert Tab.
From Illustrations Group, Click on Clip Art

Then Select a Collection and press Go Button

e hd o=

Click on a clip from the collection

m Wicrosoft FowssFoint

art or
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S. Clip will be inserted in the worksheet.
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Fig. 8.50

6. To edit the clip, Just click on the clip. This will display

Format tab. Choose the relevant group from the ribbon of
Format tab and do the necessary changes.
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8.5.2 Inserting and Editing a Picture from a File

Follow these steps to add a picture, photo or graphic from an

existing file:
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1. Click on Insert Tab.

2. From Illustrations Group, Click picture.

e -0
.

Home Insert Page Layout Formulas Data
P = =
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PivotTable Table Picture| Clip Shapes Smartirt Column Lin

Tables Mustrations
M31 Insert Picture from File
¥ iy Insert a picture from a file. A E
19 =
& Press F1 for more help.
20
Fig. 8.52
3. Now select a picture from the location of the picture (where
you have stored the picture) and press enter or click on
insert button.
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4. The picture is added on the excel sheet. Click on the
picture to activate Format tab as shown below along with
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its ribbon showing groups like Adjust, Picture Styles,
Arrange and Size. Use any of the groups to make necessary
changes in the picture appearance.
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INTEXT QUESTIONS

1. Write True or False for the following statements

(@) Format picture displays all the images properties in
a separate window.

(b)  Activate the image you wish to edit by clicking on it
once with the mouse.

(c) Line charts show the proportion of each component
value to the total value in a data series.

(d)  Pie charts are useful to compare the trends over time.
2. Fill in the blanks

(@) Each autoshape can be rotated by first clicking
button on the drawing tool bar.

(b) More effects can be changed using the

picture toolbar.
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(c) displays all the image properties in a
separate window.

(d) show the relative contributions that
each data series takes up.

(e)  You have to enter the name of the chart and titles for

8.6 WHAT YOU HAVE LEARNT

In this lesson you learnt about the creation of charts and graphics.
On the basis of data entered in a worksheet you can create a bar
chart, line chart or pie chart, you can add title, legend, data labels
and grid lines to the chart. Moreover, you learnt about
autoshapes and clip art also.

8.7 TERMINAL QUESTIONS

1.

® N o o

10.

What is the importance of charts and graphics in providing
information?

Briefly explain any five different components of a chart?

Explain the process of creating a chart using Chart Wizard
dialog box.

Briefly explain the following:

a. Bar charts,

b. Pie charts,

List any four features of Chart Formatting toolbar.

How do you copy a chart to Word created in Excel 20077
List any five categories of AutoShapes in Excel.

You are asked to prepare a flow chart. What kind of
AutoShapes you would like to use?

Explain the steps in adding a Clip Art to your worksheet?

How do you add a photo or graphic to your worksheet from
existing file?
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11. What is the main differences between (a) a column chart
and (b) a bar chart.

12. Write a note on SmartArt.

8.8 FEEDBACK TO INTEXT QUESTIONS

1. (@) True
(b) True
(c) False
(d) False
2. (a) free rotate
(b)  picture
(c) format picture

e

Area charts

(e) X,Y axes




